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 Warning! Potentially lethal voltages exist within the amplifier when power is applied. 

Never attempt to handle or probe the amplifier with power applied.  

 Hazardous voltages are present at the motor output terminals, input power connection, 
and within the sheet metal enclosure.  Disconnect the power before plugging / 
unplugging any connections or before servicing or disassembling the enclosure. 

 These amplifiers are capable of producing large amounts of energy. Serious injury or 
death can result from improper motor or load movement.  

 Do not connect the motor to the system load during initial testing and installation. 

 Be sure power is off when inserting or removing connectors or connections. 

  

 

CAUTION! READ THIS SECTION BEFORE PROCEEDING. 
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1 Introduction 

This manual describes the operation and installation of the VSA Series digital Pulse Width Modulated (PWM) 
Servo Amplifiers manufactured by Varedan Technologies. 
 
The VSA Series are designed for high performance OEM applications requiring PWM switching type 
amplifiers.  These fully digital servo amplifiers are available in a variety of power ranges to drive three-
phase brushless motors, single-phase brush-type motors or voice coils.  These amplifiers operate in 
position, velocity, or torque (current) mode using either an analog input, a digital command, or 2-phase sine 
analog input mode. 
 
Programmable commutation options include sinusoidal from a motor mounted encoder, externally 
commutated 2-phase sine inputs or trapezoidal commutation using motor mounted hall sensors.  
 
The design of these amplifiers includes an on-board high-speed Digital Signal Processor (DSP) which 
performs the PID loop controls as well as monitors all key system functions in real-time to protect the 
amplifier in the event of a system fault.  
 
Communication options include Ethernet and RS-232 interfaces.  An intelligent operating system allows 
setup and storage of all system parameters using simple ASCII commands over the communications 
interface.  The communications interface can also be used to view all operating parameters in real-time. 
Non-volatile memory provides storage of the parameters during power off conditions.  To automate the 
process of setting up multiple units with the same configuration, a text file can be downloaded to each unit. 
 
A PC based graphical user interface (GUI) utility software with the built-in digital oscilloscope is provided to 
reduce testing and debugging time of the user applications.   
 
Through this manual, VSA digital PWM amplifier is referred either as the Amplifier or the Drive. 
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2 Specifications 

 

2.1 Electrical Specification 
 

Parameter VSA1-0510 VSA2-1530 

AC Supply Voltage Input N/A 80VAC – 240VAC,  
1 or 3-phase 

DC Bus Voltage Input 24VDC - 80VDC 90VDC – 380VDC 

Keep Alive Voltage (optional) 24VDC 24VDC 

Continuous Current 5A 15A 

Peak Current ±10A ±30A 

Power Dissipation at Continuous Current 325W TBD 

Switching Frequency 40 KHz 25 KHz 

Current Loop Bandwidth up to 6KHz up to 4KHz 

Current Command Signal +/-10V Differential +/-10V Differential 

Current Transconductance 1Amp/1Volt 3Amp/1Volt 

Operating Mode 3-phase Torque/Force mode with commutation 
3-phase AB Current mode, no commutation 
Single-phase H-bridge current mode 

Feedbacks Incremental Encoder 
Analog Sin/Cos Encoder 
Absolute Biss Encoder, Biss, EnDat 
Hall   

Motor Initialization Mode Constant Current Phasing 
Pulse Current Phasing (TBD) 
Hall 

 

2.2 Mechanical Specification 
Parameters VSA1-0510 VSA2-1530 

Length 5.5 inch (139.7 mm) 8.07 inch (205 mm) 

Width 1.3 inch (33.0 mm) 5.06 inch (128.5 mm) 

Height 3.55 inch (90.1 mm) 2.64 inch (67 mm) 

Weight 0.7 lb (0.31 kg) 3.0 lb (1.36 Kg) 
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2.3 Mounting Dimensions 

2.3.1 VSA1-0510 dimension 

 

         

 

2.3.2 VSA2-1530 dimension 
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3 Model Numbering 
(TBD) Model number breakdown: VSAn-CCCC-XXYY_ZZZ  
 

Field Number Description Available Options Notes 

n Varedan Digital PWM 
Amplifier 

VSA1, VSA2 Product Series 

CCCC Current Level 0510 – 5A continuous, 10A peak  

1530 – 15A continuous, 30A peak  

XX EMI filter board 00 – No filter board 
01 – 2MHz low pass filter 

VSA1 only 

YY Expansion digital Interface 
board 

00 – No Expansion board 
01 – Customer specified interface 

Optional 

ZZZ Customer configure code Contact factory Optional 
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4 Package overview 

4.1 VSA1-0510 package overview 

4.1.1 Front View 

 

4.1.2 Side View 

                       

 

 

4.2 VSA2-1530 package overview 
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4.2.1 Front View 

 

 

 

4.2.2 Left View 

 

 

4.2.3 Right View 
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4.2.4 Top View 

 

 

 

5 LED Display 
One LED display indicates the basic status of VSA drive. 

Green Amplifier enabled, no faults 

Amber Amplifier disabled, no faults.  Motor dynamic braking. 

Red Faults. Amplifier disabled.  Motor in free-wheeling mode. 

 

6 Interface Connecters Pinouts 

6.1 P1 – IO, Aux-Encoder Interface, Current/Velocity/Position Analog Command 
Mating Connector = Amphenol 17EHD-026-P-AA-0-00 or equivalent 

Pin 
Number 

Signal Direction Voltage 
Level 

Description 

1 IN1 Input 5-24V Opto-Isolated Input - (Note1) 

2 IN2 Input 5-24V Opto-Isolated Input - (Note1) 

3 IN3 Input 5-24V Opto-Isolated Input - (Note1) 

4 IN4 Input 5-24V Opto-Isolated Input - (Note1) 

5 IN5 Input 5-24V Opto-Isolated Input - (Note1) 
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6 IN COM – – Return for all Opto-Isolated Inputs - (Note1) 

7 OUT1 (Fault) Output 5-24V Opto-Isolated Output - Fault - (Note2) 

8 OUT2 Output 5-24V Opto-Isolated Output - (Note2) 

9 OUT3 Output 5-24V Opto-Isolated Output - (Note2) 

10 Analog Output Output 0-5V DAC generated Analog Output 

11 CMD A+ Input +/-10V Differential Current/Velocity/Position 
Command 

12 CMD A- Input +/-10V Differential Current/Velocity/Position 
Command 

13 CMD B+ Input +/-10V Differential Current/Velocity/Position 
Command 

14 CMD B- Input +/-10V Differential Current/Velocity/Position 
Command 

15 Common --- --- System Common 

16 Common --- --- System Common 

17 OUT COM – – Return for all Opto-Isolated Outputs - (Note2) 

18 +5V Out Supply +5VDC Encoder/IO power - (Note3) 

19 +5V Out Supply +5VDC Encoder/IO power - (Note3) 

20 Common --- --- System Common 

21 Aux Encoder I- In/Out +/-5V Auxiliary Encoder Interface - Index 

22 Aux Encoder I+ In/Out +/-5V Auxiliary Encoder Interface - Index 

23 Aux Encoder B- In/Out +/-5V Auxiliary Encoder Interface – B Channel 

24 Aux Encoder B+ In/Out +/-5V Auxiliary Encoder Interface – B Channel 

25 Aux Encoder A- In/Out +/-5V Auxiliary Encoder Interface – A Channel 

26 Aux Encoder A+ In/Out +/-5V Auxiliary Encoder Interface – A Channel 

 

6.2 P2 – Main Feedback Interface 
Mating Connector = Amphenol 17EHD-015-P-AA-0-00 or equivalent. 

Pin 
Number 

Signal Direction Voltage 
Level 

Description 

1 Hall U Input 0-5V Hall Position Sensor Input 

2 Hall V Input 0-5V Hall Position Sensor Input 

3 Hall W Input 0-5V Hall Position Sensor Input 

4 BiSS/Endat Data - In/Out +/-5V Digital Encoder Data- 

5 BiSS/Endat Data + In/Out +/-5V Digital Encoder Data+ 

6 Main Encoder I +, 
BiSS/Endat Clock + 

In/Out +/-5V Quadrature/Sine-Cosine Index +, 
Digital Encoder Clock + 

7 Main Encoder I -, 
BiSS/Endat Clock - 

In/Out +/-5V Quadrature/Sine-Cosine Index -, 
Digital Encoder Clock - 
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8 Motor Temp + Input --- NTC/PTC Motor Temp Sensor 

9 Motor Temp - Input --- NTC/PTC Motor Temp Sensor 

10 +5V Output Output +5VDC Maximum current 1A 

11 Common --- --- System Common 

12 Main Encoder A+ Input +/-5V Quadrature/Sine-Cosine A+ 

13 Main Encoder A- Input +/-5V Quadrature/Sine-Cosine A- 

14 Main Encoder B+ Input +/-5V Quadrature/Sine-Cosine B+ 

15 Main Encoder B- Input +/-5V Quadrature/Sine-Cosine B- 

 

6.3 RS232 Serial Communication 
RS232 communication is provided through the expansion board option.  

Mating Connector = Standard RJ11 

Pin 
Number 

Signal Direction Voltage 
Level 

Description 

1 No Connect --- --- --- 

2 TXD Input +/-15V Host TX. Data input to Amplifier 

3 RXD Output +/-15V Host RX. Data output from Amplifier 

4 GND --- --- System Common 

5 DSP program --- --- Short to GND for DSP programming. Leave 
open for normal operation. 

6 GND --- --- System Common 

 

 

6.4 VSA1-0510 

6.4.1 P3 – Power and Motor 

Mating Connector = On-Shore EDZ950/7 or equivalent 

Pin 
Number 

Signal Direction Voltage 
Level 

Description 

1 Bus Common --- --- Bus Common / Return 

2 Keep Alive In +24V Keep Alive Voltage Input, 
Shares return with Bus Input Pin1 

3 Bus Input In +24-100 
VDC 

Bus Input Terminal 

4 Motor Phase A In/Out --- Motor Lead A 

5 Motor Phase B In/Out --- Motor Lead B 

6 Motor Phase C In/Out --- Motor Lead C 
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7 Chassis Ground --- --- Connection to Backplate 

 

6.4.2 J2 – STO (Safe Torque Off) interface 

Pin 
Number 

Signal Direction Voltage 
Level 

Description 

1 +5V --- --- +5V internal power 

2 STO+ AC  Opto-isolated, AC input 

3 STO- AC  Opto-isolated, AC input 

4 GND --- --- GND 

 

 

6.5 VSA2-1530 
VSA2-1530 drive power input can be either AC or DC voltage. AC power input can be either 1-phase or 
3-phase. Users cannot apply AC and DC power inputs at the same time.  

6.5.1 P8 – AC Power Input 

Mating Connector = Phoenix 1716923 or equivalent 

Pin 
Number 

Signal Direction Voltage Level Description 

1 AC 3 In 80 – 240VAC AC input phase 3 

2 AC 2 In 80 – 240VAC AC input phase 2 

3 AC 1 In 80 – 240VAC  AC input phase 1 

4 Earth --- --- Earth ground 

 

6.5.2 P9 – DC Power input 

Mating Connector = Phoenix 1777723 or equivalent 

Pin 
Number 

Signal Direction Voltage Level Description 

1 GND --- --- Power ground 

2 Bus Voltage In 90 – 380VDC DC bus voltage input 

 

6.5.3 P10 – Motor 

Mating Connector = Phoenix 1777749 or equivalent 

Pin 
Number 

Signal Direction Voltage Level Description 

1 Earth --- --- Earth ground 
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6.5.4 P11 – Keep Alive and Brake 

Mating Connector = Wurth 691351500004 or equivalent 

Pin 
Number 

Signal Direction Voltage Level Description 

1 Keep Alive In +24V Maximum 30V 

2 Keep Alive  In +24V Maximum 30V 

3 GND --- 0V  Ground 

4 Brake output Out --- Motor break 

 

6.5.5 P6 – STO (Safe Torque Off) interface 

VSA2-1530 has 2 independent STO input channels. Either STO channel in active state will disable the 
drive. 

Mating Connector = Wurth 691361300004 or equivalent 

Pin 
Number 

Signal Direction Voltage 
Level 

Description 

1 STO IN1+ AC Max 60V Opto-isolated, AC input 

2 STO IN1- AC Max 60V Opto-isolated, AC input 

3 STO IN2+ AC Max 60V Opto-isolated, AC input 

4 STO IN2- AC Max 60V Opto-isolated, AC input 

 

6.5.6 P13 – Regen Resistor Connection 

VSA2-1530 provides an external regen resistor connection.  

Mating Connector = Phoenix 1777989 or equivalent 

Pin 
Number 

Signal Direction Voltage Level Description 

1 Regen+ Out --- Bus voltage to one side of external regen 
resistor 

2 Regen- Out --- The other side of external regen resistor 

 

6.6 I/O Notes 
Note1: Each Opto-isolated Input has the following circuit with bi-directional Opto-isolator.  The Input circuit 
can be either pulled up or pulled down using the “IN COM” pin that is shared across all input channels.  If 
no external voltage is available, and the opto-isolation is not required, +5V or Common from the amplifier 

2 Motor phase C In/Out --- Connect to motor lead C 

3 Motor phase B In/Out ---  Connect to motor lead B 

4 Motor phase A In/Out --- Connect to motor lead A 
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can be used. 

 

Note2: Each Opto-isolated Output has the following circuit with a solid-state relay capable of 100mA load 
current.  The Output circuit can be either pulled up or pulled down using the “OUT COM” pin that is 
shared across all output channels.  If no external voltage is available, and the opto-isolation is not 
required, +5V or Common from the amplifier can be used. 

 

Note3: Total +5V Out current is limited to 1A. 
 
Note6: Shells of DSUB connectors are Chassis Ground Referenced to the amplifier case cover. 
 

7 Communication Interface 

7.1 RS232 Serial Interface 

 

The E1 port optional plug in card adds RS232 serial communications to the VSA1 amplifier.  This card 
has a standard RJ11 connector which brings out RS232 level signals. 
The VSA can communicate with a host via RS-232 using a three wire DTE to DTE cross over serial cable.  
The communication setting is 115.2K baud rate, 8 bit data, no parity, no handshake. 

The VaredanGUI is the preferred method of communicating with the drive, but a standard ASCII terminal 
can also be used. 

 

7.1.1 PC based terminal software options 

Many terminal programs can be used to communicate with the VSA1 series amplifiers over the serial port.  
We recommend the use of the freely available Open Source TeraTerm. 

1          6
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TeraTerm can be downloaded from the following link: https://ttssh2.osdn.jp/ 
 

7.1.2 RS232 serial port software configuration 

The COM port settings for the VSA1 amplifier using the RS232 card are: 

Baud Rate = 115200 
Data = 8bit 
Parity = none 
Stop = 1bit 
Flow Control = none 
If using TeraTerm, we recommend a transmit delay of 20ms/char and 20ms/line while sending 
configuration files.  Substitute your active COM port in the setup information shown. 
 

 

 

7.1.3 Terminal Host Communication Protocol 

Once the host communication program is properly configured and the host cable is connected, apply 
power to the VSA. The VSA should respond with the sign-on message which should look like the 
following text in the terminal window. When the amplifier is ready to accept a new command, the user 
prompt character “>” will be shown. 

Commands can now be entered. The example below shows the reply from the CONFIG? command.  It is 
recommended to confirm the configuration of the amplifier to make sure it matches the motor and the 
expected running parameters. 
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Once desired parameter values are found, use the WRITE command to save the changes.  If a RESET is 
issued before the WRITE command, any parameter changes will be lost, and the amplifier will revert to the 
last saved set of parameters. 

The following describes the command syntax and amplifier response format: 

Commands are entered using ASCII characters from the terminal. To enter a command with a user entered 
data field, the command name is followed by a “:” or “=” followed by the data for the command, followed by 
Enter (carriage return) is used. As a minimum, all commands must be terminated by the carriage return 
character (ASCII 13). The line feed (ASCII 10) is optional and is not used by the amplifier. 

A typical command has the following ASCII format. Control characters are shown in <>: 

CONFIG?<Cr><Lf> 

POLES=4<Cr><Lf> 
All characters sent to the amplifier are echoed back if echo has been enabled. When the amplifier has 
accepted the command, the prompt “>” is returned. 

 



VSA Series Digital PWM Servo Amplifier Technical Reference Manual 

23 
 

8 Install GUI Software 

The PC based Varedan GUI, with its built-in command stimulus and real-time oscilloscope signal tracer 
views, reduces the requirements for external equipment while setting up new systems. The standard 
RS232 and Ethernet based communications easily connects with all modern computers.  Full system 
configuration can be saved and uploaded for quick and easy drive provisioning. 

8.1 Open the installation file 
Double click on the “VaredanGUI.msi” icon to run the installer. 

 

8.2 Start the installation 
Click the “Next” button in the installation window to start the installation. 

 

8.3 Select installation folder 
Verify that the default installation location found in the “Folder” area is appropriate and click on the “Next” 
Button to continue. Alternatively, change the installation location if necessary, by clicking the “Browse” 
button and selecting a new location. 

 

8.4 Confirm installation 
Click the “Next” button to complete the installation. 
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8.5 Complete and close installation window 
Click on the “Close” button to close the installation window. 

 

 

9 GUI Feature Details 
The Varedan GUI main menu has five major function regions.  It consists of top pull-down manual bar, 
side configuration tree, and right-side quick look status panel, and lower connection status and drive 
firmware version indicators.  The detailed GUI descriptions can be read from “Help” pull-down manual. 
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9.1 Top pull-down manual 
The Varedan GUI when it first runs shows five major regions of functionality as shown below 

9.1.1 File 

File menu allows users to load and save customized GUI configurations for a special application. 

 

 

9.1.2 Drive 

When the GUI is offline the Drive menu allows the selection of all supported Varedan Drives.  Different 
menu items and form objects are enabled or hidden based on the supported features for the selected 
drive.  For VSA1, Select drive “VSA1 (4055)”. 
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9.1.3 Comms 

The VSA communicates with a host via RS-232 serial connection or via Ethernet if the option is enabled. 
The "Comms" menu allows you to select between the various methods of communications supported by 
the utility.  For example for RS232, select “Serial->COM1”, if cable connecting to PC COM1 port. 

 

 

After right serial port get selected, a communication link should be built between GUI and the drive.  The 
bottom grey “OFFLINE” status should turn to be green “CONNECTED via COM1”. 
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9.1.4 Tools 

Tools” manual has the following function items: Terminal, Analyze, Script, Save settings to Drive, Update 
Firmware, and Restore Defaults. 

 

 

9.1.4.1 Terminal 

To open a live Terminal session with the attached drive, select "Terminal" from the main GUI menu. The 
Terminal opens in a separate window and provides a way to send commands to the drive, or observe the 
commands sent by the GUI to the drive.  For example, you can type in VERSION? and I? at command 
line to show the attached drive version and check real-time 3 phase motor current readings. 
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9.1.4.2 Analyze 

The GUI utility provides Signal Tracer, which allows sets of signals to be displayed on the oscilloscope 
interface. To open the Signal Trace, select "Analyze" located on the top-right of main GUI menu, or select 
“Tools->Analyze”.  For detailed information, please reference “Help->GUI Help” menu. 

 

9.1.4.3 Script 

Script allows users to execute a series commands at user prefer sequence. 

 

9.1.4.4 Save settings to Drive 

The function allows users save their configurations to the flash memory of the attached drive.  For a 
specific application, once users complete all drive settings, they save these settings to the drive.  
Otherwise if power is removed from attached drive, these settings will be lost.  

 

 

9.1.4.5 Update Firmware 

Reference to section 14, Firmware Update. 
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9.1.5 Help 

“Help” manual provides detailed descriptions for all GUI functions.  User should reference “Help” 
document for detailed GUI supports. 

 

 

9.2 Main menu Analyze and Reset Drive buttons 
Main GUI menu top-right side have 2 quick buttons  

 

“Analyze” is used to open Signal Tracer, which allows sets of signals to be displayed on the oscilloscope.  
“Reset Drive” provides a hardware reset from GUI to the attached drive. 

 

9.3 GUI analyze tool - real-time oscilloscope 
Please reference to the section 9.1.4.2. 

 

9.4 QuickLook panel 
The QuickLook panel displays an overview of critical system flags and settings for the live operation of an 
attached drive. From this panel you can see the status of the inputs and outputs, the drive status flags, 
critical motor parameters, enable/disable the amp and stop motor motion.  For detailed, check main menu 
“Help->GUI Help”. 
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9.5 Configuration Tree 
Configuration tree allows users to set operation details from GUI.  It consists of Amplifier, I/O, Motion, 
Motor, and System 5 tabs. 

 

9.5.1 Amplifier Tab 

“Amplifier” tab selects Amp mode, setup current loop gains, and position loop gains.   
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Current available Amp Mode Select as: 

 

AMP Mode Selection Description 

Single-Phase Torque Control Single phase motor like VCM, or single coil current 
control.  H-bridge drive.  Motor leads connect to phase 
A and C outputs. 

Three-Phase Ext. Commutation (ABSine) 3-phase motor current control.  Host sends 2 current 
reference commands.  Amplifier does not perform motor 
commutation. 

Three-Phase Torque  3-phase synchronous torque/force/current control.  Host 
send 1 torque/force/current command.  Drive take care 
of motor commutation. 

 

9.5.2 I/O Tab 

“I/O” tab selects user I/O inputs and outputs, current command input sources, DAC analog output to 
interface I/O connector.  VSA1 has 5 general purpose input IOs and 3 general purpose output IOs.  Users 
can select available functions and active state for each IO. 
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User I/O – Inputs Description 
User Input General purpose user input (for use in programs) 
Enable Amplifier Enable amplifier from input I/O signal 
Program Select N/A 
Limit Pos N/A 
Limit Neg N/A 
Stop N/A 
SFI Special user function input 
Reset Amplifier Hardware reset amplifier 

 

User I/O – Outputs Description 
User Output General purpose user output (for use in programs).  Click “Assert” to set 

active state to IO. 
Fault Amplifier fault 
At Speed N/A 
Zero Speed N/A 
I2T Foldback N/A 
At Position N/A 
Disable Amplifier enabled or disabled (handshaking to enable input) 

 

Analog Input Description 
A offset N/A 
B offset N/A 
A Polarity Normal/Inverted.  Command A input polarity control 
B Polarity Normal/Inverted.  Command B input polarity control 
Transconductance 1V/1A, unchangeable 

 

For 3-phase torque/force control and single phase motor, user can select command A or command B as 
input resource.  For 3-phase ABsine mode, the selection is ignored.  Both command A and B are current 
command inputs.   

Command Source Description 
None No command inputs 
Cmd A Select command A as torque/current source 
Cmd B Select command B as torque/current source 
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N/A N/A 
Step & Dir N/A 

 

For functionality of “Analog Output”, reference to section 10, user analog DAC output. 

 

9.5.3 Motor Tab 

Motor tab allows users to set commutation method, to change motor phase leads, to set continuous and 
peak current limits, and to set motor encoder feedbacks. 

 

9.5.3.1 Commutation 

3-phase motor commutation parameters setups.   

9.5.3.1.1 Mode 
select one of the commutation modes.  Currently only sinusoidal is valid 

.Mode Description 

6 state N/A.  Hall sensors 

Sinusoidal Encoder sinusoidal commutation 

1.8o stepper N/A. 1.8 degree step move 

3.6o stepper N/A. 3.6 degree step move 

 

9.5.3.1.2 Alignment 

3-phase motor phasing and initialization options. 
Alignment Description 

Halls Use hall sensor provide initial phase angle. 

Halless Constant current phasing 

Absolute Absolute encoder feedback 

 

9.5.3.1.3 Motor poles 
For rotary motor, set the number of motor poles.  For linear motor, set the number of motor poles = 2. 
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9.5.3.1.4 Offset Value 
Sets direct commutation angle offset in electrical degrees. Typically, this is used for aligning absolute 
feedback devices. 

9.5.3.2 Phasing 

Sets motor phase leads relationship. 

9.5.3.2.1 Halls 
Set the hall state relationship to the motor phases. This has same action as swapping the hall wires. For 
example, setting the sequence to "ACB" swaps phase B and C. 

Halls Description 

ABC Hall sequence – ABC 

ACB Hall sequence – ACB  

BAC Hall sequence – BAC  

BCA Hall sequence – BCA  

CAB Hall sequence – CAB  

CBA Hall sequence – CBA  

 

9.5.3.2.2 Motor 
Swap motor leads to change move direction. 

Motor Description 

ABC Normal motor phase leads ABC 

ACB N/A  

BAC N/A  

BCA N/A  

CAB N/A  

CBA Swap motor phase leads A and C  

 

9.5.3.3 Motor feedbacks 

Sets motor encoder feedback configuration. 

9.5.3.3.1 Type 
Encoder feedback type 

Type Description 

None No feedbacks, open loop 

Incremental (A Quad B) Incremental encoder  

Biss (Single Turn) Absolute Biss encoder  

Incremental (Aux A Quad B) Auxiliary incremental encoder 

EnDat Absolute EnDat encoder 

Analog Sin/Cos Analog sin/cos encoder 

 

9.5.3.3.2 Resolution 
For rotary motor, enters encoder counts per mechanical revolution.  For linear encoder, selects motor 
poles equals 2 and enters encoder counts per pole pair. 
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9.5.3.3.3 Invert Direction 
TBD.  Check this box to reverse actual position direction. 

 

9.5.3.4 Limits 

For user applications, sets current limits for safety operation. 

9.5.3.4.1 Continuous current 
Maximum continuous current (Amp) for safety operation.  When actual motor phase current exceeds this 
setting, the motor I2T over-current protection becomes active. 

9.5.3.4.2 Peak current 
Maximum peak current (Amp) allowed for safety operation.  Drive will be in fault state if actual current is 
over the limit. 

9.5.3.4.3 Time at Peak 
Time in seconds to determine I2T integration limit.  If I2T over the limit, drive will report I2T over current 
fault. 

I2T limit setting is computed as: 

I2T limit setting = [(Peak current)2 – (Continuous current)2]*(Time at Peak) 

9.5.3.4.4 Velocity limit 
TBD. 

 

9.5.4 System Tab 

 

System tab displays the drive fault status.  Details refences to protection function at section 13.  “Clear 
Faults” clears the fault condition if the fault does not reoccur.  

System tab also displays “Amplifier Temperature”, “Bus voltage”, and “Keep Alive” voltage level.  
Displayed voltage values may have +/-10% measurement errors. 
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10 User programmable analog output 
VSA1 amplifier has a programmable analog output for user monitoring.  Hardware output is located at 
connector P1-pin10, with voltage range from 0 to 5V, where 2.5V references to 0 signal level.  Users can 
select and scale output signal either form GUI or from host terminal. 

10.1 Select analog output from GUI 
The 1 channel analog output signal can be selected from GUI configuration tree I/O tab.   

             

For example, the above setts that the analog output is phase A measured current.  0.5A/1V, that means 
maximum measurement is 2.5A(+/-1.25A) for 5V scale.  Reverse the polarity of the signal.   

Analog Output = Signal*Scale*Polarity 

Available signals can be selected from “Signal” pull-down menu. 

Signal Description 

Actual Position N/A.  Actual position measured from encoder 

Commanded Position N/A.  Position reference from host 

Actual Velocity N/A.  Measured velocity from encoder 

Commanded Velocity N/A.  Velocity loop reference 

Phase A Current Motor phase A current measured from current sensor 

Phase B Current Motor phase B current measured from current sensor 

Phase C Current Motor phase C current measured from current sensor 

Cmd Vector Current N/A 

Vector Current 3-phase synchronous current control, q axis current feedback 

Direct Current 3-phase synchronous current control, d axis current feedback 

CMD A Analog In Current reference input from CMD A differential pair 

CMD B Analog In Current reference input from CMD B differential pair 

CMD A Scaled N/A 

CMD B Scaled N/A 

DAC A Cmd Out N/A 

DAC B Cmd Out N/A 

Test Signal Electrical angle in 3-phase synchronous current control 
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10.2 Select and scale analog output from host terminal 
If GUI is not available. Users can use host terminal to set up analog output signal for monitoring.  

Step 1:  use ANALOGOUT command to select output signal. Refence to serial command list for details. 

For example, to select “Phase A Current” as the analog output signal, at console 

> ANALOGOUT:4 <CR> 

Step 2:  use ANALOGSCALE command to scale the output signal level 

For example, to scale the output signal 0.5V/A, at console 

> ANALOGSCALE:0.5 <CR> 

Step 3:  use AOUTPOL to set output signal polarity 

For example, to reverse the output signal polarity, at console 

> AOUTPOL:1 <CR> 

 

11 Applications Information 
The VSA current loop controls apply to different operation modes.  For 3-phase motors, users can 
configure the drive as 3-phase synchronous control mode or 3-phase ABSine mode.  For single phase 
motor or single coil, the drive can be configured as single phase H-bridge mode.  How that current gets 
commanded and where the command comes from is determined by the amplifier’s mode of operation. In 
all modes of operation, a “command current” must be generated from either an external controller or from 
inside the amplifier. The amplifier uses this current command to internally close the current loop in each 
motor phase using pulse-width modulation (PWM) by allowing more or less current to flow through the 
output transistors. 

For modes that use an external command current, the command current can come from one of two sources; 
the analog input(s) or as a user command from the user interface. 

For modes that generate the current command internal to the amplifier as in the case of velocity or 
position modes, a higher-level control loop is used to generate the command. For velocity mode, the 
current command comes from the output of the velocity loop. The command for the velocity loop comes 
from either the analog input, or as a user command from the user interface. The position loop command 
comes from either an external source over the user interface or from the internal indexer when the 
amplifier is commanded to move to a specific position 

 

11.1 3-phase motor synchronous force/torque/current control 
In this mode, users send 1 channel force/torque command to the drive.  The amplifier uses encoder to 
provide motor commutation.  The current controllers generate internal 2 channel d,q current references 
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synchronized with motor electrical angle and close current loops.  With synchronous current control, phase 
delay caused by sinusoidal motor commutation is removed.  Balanced space vector PWM is applied to 
obtain additional 15% phase voltage gain.   

3 Phase A/B Current Mode Description 

Motor leads connection Drive phase A, B, C outputs 

Force/Torque/Current command 
CMD A or CMD B 

CMD A +/-10V differential  If CMD Source = CMD A 

CMD B +/-10V differential t If CMD Source = CMD B 

Current control Synchronous PI controllers  

Transconductance 1V/1A 

PWM Space vector PWM 

 

11.1.1 Amplifier operation mode and gains 

 

From GUI configuration tree->Amplifier tab, selecting operate mode “Three-Phase Torque Control”. 

Sets current PI control loop gains.  “Current I Gain Limit” is not implemented and should be ignored. 

Without GUI, users can also set the same amplifier operation mode and gains from host terminal as: 

> AMPMODE:4 <CR>   (Amplifier operation mode – Three Phase Torque Control) 

> CPGAIN:15.68 <CR>   (Current loop proportional gain 15.68) 

> CIGAIN:0.8033 <CR>   (Current integral gain 0.8033) 

Reference to serial command list for detailed descriptions. 
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11.1.2 I/O selection 

 

An IO setup example is shown on the above GUI, “User I/O Input #2” is selected as the amplifier enable 
signal, active high.  “Cmd B” input is configured as force or torque command source.  Cmd “B Polarity” is 
normal, non-inverted.  Notice that “Out #2” is selected to be “Disable” signal, active high.  The output #2 
can be used as the handshake signal of amplifier’s enable signal.  If Out #2 level is low, the amplifier is 
enabled.  Otherwise, it is disabled.  In this mode, when host issues the enable amplifier command, the 
amplifier will first check if motor initialization (phasing) has been complete.  If this is the first enable 
command after power up, the amplifier performs motor initialization (or motor phasing) and then close the 
current loop.  Motor phasing may take several seconds to complete depending on which the initialization 
method.  Therefore, host should check the enable handshaking signal to make sure the amplifier has 
been enabled before issuing a current command.  

Without GUI, users can also set the same amplifier I/O selections from host terminal as: 

> MAPIN:2:1  <CR>   (User input #2, as Enable Amplifier) 

> INPOL:2:1 <CR>   (User input #2, active high) 

> EXTCMDIN:2 <CR>   (Command source – Cmd B) 

> ANALOGBPOL:0 <CR>   (Analog input B polarity - normal) 

> MAPOUT:2:6 <CR>   (Map user output #2, as Disable amplifier) 

> OUTPOL:2:1 <CR>   (User output #2, active high) 

Reference to serial command list for detailed descriptions. 
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11.1.3 Motor configuration and current limits 

 

On the above GUI setups, Mode is select as “Sinusoidal” commutation and “Alignment” select is 
“Halless”.  Current firmware only supports “Sinusoidal” commutation.  Stepper mode is not implemented 
yet.  For this selection, to align the motor permanent magnets to its coil flux, a constant current motor 
phasing will apply for initialization.  This rotary motor has 8 poles.  Incremental encoder provides 8000 
quadrature counts per mechanical revolution. 

For linear motor application, select “Motor Poles” to 2.  Encoder resolution is the quadrature counts for 
per pole pairs.  

Motor “Phasing” is CBA.  That means that the amplifier swapped phase A and phase C outputs to match 
the encoder direction.  If you want to reverse current direction, swap phase A and C by selecting ABC 
from “Phasing” menu.   

Current limits set as “Continuous current” 5.0A, “Peak Current” 12.0A, “Time” 3 seconds.  That means if 
motor current over 12A at any time, the drive will be disabled. An over current fault will report.  Also, if 
motor (current2 – 52)*time is greater than (122 – 52)*3, an I2T fault will report. 

Without GUI, users can set motor output configuration from host terminal console as: 

> COMMUTATION:1 <CR>   (Sinusoidal commutation) 

> ALIGNMODE:1 <CR>   (Motor current phasing or initialization) 

> POLES:8 <CR>   (8 poles motor) 

> PHASING:CBA <CR>   (Motor phase A and C) 

> ENCODERTYPE:1 <CR>   (Quadrature encoder) 

> ENCODERCOUNT:8000 <CR>   (8000 encoder counts per mechanical revolution) 

Set current limits as: 

> CCLIMIT:5.0 <CR>   (continuous current 5.0A) 

> PKLIMIT:12.0 <CR>   (peak current 12.0A) 
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> PKTIME:3.0 <CR>   (peak Current Time 3 seconds) 

Reference to serial command list for detailed descriptions. 

 

11.1.4 Motor initialization (phasing) 

For 3-phase synchronous motor, to obtain maximum torque/force, the motor phase current must be in 
phase with the motor back-emf.  If the motor phasing is not correct, the motor cannot get its maximum 
torque/force and the current control loops may become unstable. 

The firmware provides different choices for motor initialization (phasing), including current phasing, pulse 
current phasing, hall sensor phasing, and absolute encoder phasing.  Users can select motor initialization 
method from Commutation->Alignment tab.   

 

11.1.4.1 Constant current phasing 

This method does motor initialization by applying a constant current with known electrical angle.   

The constant current is defined as 50% of the peak current value, which users defined at current limits.  
During motor phasing, current ramps up from 0 to the constant current in 2 seconds.  To avoid motor 
initially stay at unstable pole position (180-degree phase reverse to the stable one), electrical angle also 
linearly turns from 0 degree to 90 degree as current ramping.  Then drive holds the constant current and 
the 90-degree electrical angle for 3 seconds.  Encoder position is recorded at the end of 3 second hold 
time as the electrical angle offset value.   

These phasing parameters are not implemented as user parameters yet. 

 

11.1.4.2 Hall phasing 

Some user applications require no motion during motor initialization.  If hall sensors are available, the 
amplifier can read a coarse phasing value from hall states.  For 3 hall sensors setup, total 6 different 
states for a 360-degree electrical angle range.  Each hall state represents 60-degree electrical angle 
range.  Therefore, there is a maximum +/-30-degree electrical angle error from the first reading of a hall 
state.  However, with this coarse phase information, the amplifier can close the current loop and is under 
host control.  To get a better accurate phasing information, electrical angle offset gets updated if the 
encoder position of the first hall transition is detected.  Encoders are then required to calculate electrical 
angle changes after the motor initialization completed.  

 

11.1.4.3 Pulse current phasing 

For the applications require no motion before the amplifier gets enabled, another choice is current pulse 
phasing.  Hall sensors are not required.  In this case, the amplifier sends a sequence of positive and 
negative current pulses to the motor.  Encoder detects the very small motor vibrations (in um) and 
calculates the phase angle.  The disadvantage of this method is that the phase angle calculated is not 
accurate as the constant current phasing. 

This method is not under GUI control yet. 
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11.1.4.4 Absolute encoder 

For absolute encoder, motor commutation information to encoder is fixed and will not change if the drive 
power is removed.  In this case, users can directly enter the known motor initial phase offset into “Offset 
Value” of motor commutation tab. 

 

11.1.5 Motor test run 

The test motor is a 3-phase rotary motor with phase-to-phase inductance 6mH and phase-to-phase 
resistance 1.3 ohm.  Amplifier get enabled by active high signal from connector P1 pin-2.  GUI 
“QuickLook” panel I/O sector shows the enable amp is asserted and “Status” bar shows the amplifier is 
enabled.  Output #2 “Disable” is highlighted to show the signal is active. 

 

Clicking “Analyze” icon at the main menu to open a signal tracer scope.  Trace 1, blue color, shows motor 
electrical angle signal for a constant speed rotation.  The test signal is configured as the motor electrical 
angle. 
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11.1.6 Save user configurations to Drive 

All new parameter settings will be lost if drive’s power is removed or a reset command is issued.  Users 
can save these parameters to the drive’s flash memory either from GUI tools or to use WRITE command 
from terminal console. 

 

11.2 3-phase motor A/B sinusoidal current control 
Host sends two current channel commands, CMD A and CMD B, as motor phase A and phase B current 
references.  The amplifier has 2 independent current control loops for phase A and Phase B, and generate 
balanced phase C control output.  Host controller takes care of motor commutation.  The amplifier does not 
perform motor commutation.  Encoder feedback is not required.  Balanced space vector PWM is applied to 
obtain additional 15% phase voltage gain.   

3 Phase A/B Current Mode Description 

Motor leads connection Drive phase A, B, C outputs 

Current command A Motor phase A current reference.  CMD A +/-10V differential. 

Current command B Motor phase B current reference.  CMD B +/- 10V differential. 

Current control 2 independent PI controllers 

Transconductance 1V/1A 

PWM Space vector PWM 
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11.2.1 Amplifier operation mode and gains 

 

From GUI configuration tree->Amplifier tab, selecting operate mode “Three-Phase Ext. Commutation 
(ABSine)”. 

Sets current PI control loop gains.  “Current I Gain Limit” is not implemented and should be ignored. 

Without GUI, users can also set the same amplifier operation mode and gains from host terminal as: 

> AMPMODE:3 <CR>   (Amplifier operation mode – Three Phase Ext Commutation Control (AB Sine) ) 

> CPGAIN:15.68 <CR>   (Current loop proportional gain 15.68) 

> CIGAIN:0.8033 <CR>   (Current integral gain 0.8033) 

Reference to serial command list for detailed descriptions. 

 

11.2.2 I/O selection 

 

An IO selection example is shown on the above GUI.  “User I/O Input #2” is selected as the amplifier 
enable signal, active high.  Notice that “Out #2” is selected to be “Disable” signal, active high.  The output 
#2 can be used as the handshake signal of amplifier’s enable signal.  If Out #2 level is low, the amplifier is 
enabled.  Otherwise, it is disabled. 

Cmd A and Cmd B polarity” set as normal, non-inverted.  In this mode, command source selection is 
disabled.   

Without GUI, users can also set the same amplifier I/O selections from host terminal as: 



VSA Series Digital PWM Servo Amplifier Technical Reference Manual 

45 
 

> MAPIN:2:1  <CR>   (map user input #2, as Enable amplifier) 

> INPOL:2:1 <CR>   (User input #2, active high) 

> MAPOUT:2:6 <CR>   (Map user output #2, as Disable amplifier) 

> OUTPOL:2:1 <CR>   (User output #2, active high) 

> ANALOGAPOL:0 <CR>   (Analog input A polarity - normal) 

> ANALOGBPOL:0 <CR>   (Analog input B polarity - normal) 

Reference to serial command list for detailed descriptions. 

 

11.2.3 Motor configuration and current limits 

 

On the above GUI setups, motor “Phasing” is CBA.  That means that the amplifier swapped phase A and 
phase C outputs.  If you want to reverse current direction, swap phase A and C by selecting ABC from 
“Phasing” menu.  In this mode, ignore motor commutation tab. 

Current limits set as “Continuous current” 5.0A, “Peak Current” 12.0A, “Time” 2 seconds.  That means if 
motor current over 12A at any time, the drive will be disabled. An over current fault will report.  Also, if 
motor (current2 – 52)*time is greater than (122 – 52)*2, an I2T fault will report. 

Without GUI, users can set motor output configuration from host terminal console as: 

> PHASING:CBA <CR>   (Motor phase A and C) 

Set current limits as: 

> CCLIMIT:5.0 <CR>   (continuous current 5.0A) 

> PKLIMIT:12.0 <CR>   (peak current 12.0A) 

> PKTIME:2.0 <CR>   (peak Current Time 2 seconds) 

Reference to serial command list for detailed descriptions. 



VSA Series Digital PWM Servo Amplifier Technical Reference Manual 

46 
 

 

11.2.4 Motor Test Results 

The test motor is a 3-phase motor with phase-to-phase inductance 6mH and phase-to-phase resistance 
1.3 ohm.  Amplifier get enabled by active high signal from connector P1 pin-2.  GUI “QuickLook” panel I/O 
sector shows the enable amp is asserted and “Status” bar shows the amplifier is enabled.  Output #2 
“Disable” is highlighted to show the signal is active. 

 

 

Phase A command analog signal is 1.0V DC input and phase B analog signal is 2.0V DC input.  At the 
QuickLook menu, you can see real-time phase A current is 1.002 Amp and Phase B current is 1.997 
Amp.  Phase C current measured is -2.953 Amp, which theoretical should equal to the reverse sum of 
phase A and B currents. 

 

11.2.5 Save user configurations to Drive 

All new parameter settings will be lost if drive’s power is removed or a reset command is issued.  Users 
can save these parameters to the drive’s flash memory either from GUI tools or to use WRITE command 
from terminal console. 

 

11.3 Single phase motor or coil current control 
This mode is for single phase voice coil motor, brushed DC motor, or single coil current control.  Motor 
leads connecting to phase A and C of the drive outputs. 

Single Phase Current Mode Description 

Motor leads connection Drive phase A and C outputs 
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Current command (reference) 
CMD A or CMD B 

CMD A +/-10V differential  If CMD Source = CMD A 

CMD B +/-10V differential t If CMD Source = CMD B 

Current control 1 PI controller 

Transconductance 1V/1A 

PWM H-Bridge PWM 

 

11.3.1 Amplifier operation mode and gains 

 

From GUI configuration tree->Amplifier tab, select “Single-Phase Torque Control”. 

Sets current PI control loop gains.  “Current I Gain Limit” is not implemented and should be ignored. 

Without GUI, users can also set the same amplifier operation mode and gains from host terminal as: 

> AMPMODE:0 <CR>   (Amplifier operation mode – Single-Phase Torque Control) 

> CPGAIN:15.68 <CR>   (Current loop proportional gain 15.68) 

> CIGAIN:0.8033 <CR>   (Current integral gain 0.8033) 

Reference to serial command list for detailed descriptions. 

 

11.3.2  IO selection 
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An IO setup example is shown on the above GUI, “User I/O Input #2” is selected as the amplifier enable 
signal, active high.  “Cmd B” input is configured as current command source.  Cmd “B Polarity” is normal, 
non-inverted.  

Without GUI, users can also set the same amplifier I/O selections from host terminal as: 

> MAPIN:2:1  <CR>   (User input #2, as Enable Amplifier) 

> INPOL:2:1 <CR>   (User input #2, active high) 

> EXTCMDIN:2 <CR>   (Command source – Cmd B) 

> ANALOGBPOL:0 <CR>   (Analog input B polarity - normal) 

Reference to serial command list for detailed descriptions. 

 

11.3.3 Motor output configuration and current limits 

 

On the above GUI example, motor “Phasing” is ABC.  For single phase motor, phase B is ignored.  If you 
want to reverse current direction, swap phase A and C by selecting CBA from “Phasing” menu.   

Current limits set as “Continuous current” 5.0A, “Peak Current” 12.0A, “Time” 5 seconds.  That means if 
motor current over 12A at any time, the drive will be disabled. An over current fault will report.  Also, if 
motor (current2 – 52)*time is greater than (122 – 52)*5, an I2T fault will report. 

Without GUI, users can set motor output configuration from host terminal console as: 

> PHASING:ABC <CR>   (Motor phase A and C) 

Set current limits as: 

> CCLIMIT:5.0 <CR>   (continuous current 5.0A) 

> PKLIMIT:12.0 <CR>   (peak current 12.0A) 

> PKTIME:5.0 <CR>   (peak Current Time 5 seconds) 

Reference to serial command list for detailed descriptions. 

 



VSA Series Digital PWM Servo Amplifier Technical Reference Manual 

49 
 

11.3.4  Motor test results 

A test motor with coil inductance 6mH and resistance 1.3 ohm is connected to P3 pin-4 and pin-6.  
Amplifier get enabled by active high signal from connector P1 pin-2.  GUI “QuickLook” panel I/O sector 
shows the enable amp is asserted and “Status” bar shows the amplifier is enabled. 

 

A current command signal, 100Hz 1.0V peak-2-peak sinusoidal signal, is loaded to CMD B differential 
inputs at connector P1-13 and P1-14.   

Clicking “Analyze” icon at the main menu to open a signal tracer scope.  Trace 1, blue color, shows 
100Hz 1V peak-to-peak sinusoidal command.  With 1A/1V transconductance, it sends 1A peak-to-peak 
current reference.  The phase A current feedback, 1A peak-to-peak, is shown in yellow.  

 

 

11.3.5 Save user configurations to Drive 

All new parameter settings will be lost if drive’s power is removed or a reset command is issued.  Users 
can save these parameters to the drive’s flash memory either from GUI tools or to use WRITE command 
from terminal console. 



VSA Series Digital PWM Servo Amplifier Technical Reference Manual 

50 
 

12  External Safety Interface 

12.1 Safety Torque off (STO) 
Both VSA1 and VSA2 have the safe torque off function.  In the safe state, the drive get disabled by 
hardware and the motor is in free-whell state. 

The STO inputs are opto-isolated. The maximum input voltage to the opto-couplers should not over 60V. 

The user can bypass STO funcition if it does not apply to the applications.  

For VSA1, plugging a jumper between pin-1 and pin-2, and the other jumper to short pin-3 and pin-4. 

For VSA2, plugging a jumper at JP2 on the PCBA to bypass STO function. 

 

 

VSA1 STO Wiring Diagram 

 

 

VSA2 STO wiring diagram 

 

12.2 External Regen Resistor 
For VSA2 only, an external regen resistor can be connected to P13 to dissipate regenerative energy that 
exceeds the storage capacity of the bus capacitance. Users can set up turn on voltage through 
REGENVOLT command. 
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To avoid regen energy exceeds the power rating of the regen resistor, the regen turn on/off is PWM 
controlled. Users can set up PWM on duty cycle to control the regen energy that dumps to the external 
load resistor.  

REGENPWMDC command is used to set PWM on duty cycle. The minimum on duty cycle is 5%. The 
drive allows to set 0 duty cycle to turn off the regen output. 

 

12.3 Keep Alive and Motor Brake 

 

 

12.3.1 Keep Alive 

The user can provide an optional +24V input to keep the drive alive when the main bus voltage is 
removed. The external +24V generates +5V to keep all digital circuits alive without interrupting when the 
main bus voltage is turned off and then back on later.  
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12.3.2 Motor brake operation 

Some applications apply a brake to hold the axis when the drive get disabled. The brake is controlled by 
DSP I/O. When the drive gets disabled, brake can be engaged. When the drive gets enabled, brake will 
be released. An additional delay or hold on time can be added. The details are TBD. 

 

13  The Internal Protection Functions 
The amplifier has a few built-in protective functions.  The protective functions consist of 2 categories, 
warnings and faults.  In the event of a fault sensed, the amplifier is disable and status LED is red.  Motor 
is in free-wheeling mode.  In the event of a warning detected, the amplifier does not take any action.  It 
can report to host and host can decide if a necessary action should be taken. 

 

13.1 Faults 

13.1.1 Flash memory checksum error  

For a code image or user parameters stored in flash memory, a given checksum is stored as the last 
word.  When DSP loads the code image or user parameters to RAM, checksum is calculated and 
compares with the given checksum word.  If the 2 checksums are not matched, this error is asserted. 

 

13.1.2 Hardware over current 

The amplifier hardware monitors the current flows to each motor phase.  If any phase current over 42A, 
hardware detects short circuits and hardware over current fault is asserted.  

 

13.1.3 Current I2T overload 

I2T limit is defined from either the GUI setups or from the console commands.  CCLIMIT, PKLIMIT, and 
PKTIME commands set maximum continuous current, peak current, and peak time. 

I2T Limit = (PKLIMIT2 – CCLIMIT2)*PKTIME 

If real-time i2t over this limit, the over current fault is declared.   

For single phase motor,  

i2t = ( I2 – CCLIMIT2 )*t  

For 3-phase motor, 

i2t = [ (2/3)*(Ia*Ia + Ib*Ib + Ic*Ic) – CCLIMIT2 ]*t 

In i2t calculation, if i2t < 0, i2t = 0.   
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13.1.4 Motor phase over current 

If any motor phase current over the peak current, the over current fault is asserted.  Users can define the 
peak current either from GUI or use PKLIMIT command from the console. 

 

13.1.5 Hardware safety torque off (STO) 

This is not real fault.  If the STO signal is detected, the drive treats it as hardware fault and motor is in 
free-wheeling mode.  When STO signal removes, the error gets cleared itself. 

Maximum input voltage between STO+ and STO- should be no more than 40V.  

 

13.1.6 Quadrature encoder phase error 

Normally 2 quadrature inputs of incremental encoder, A and B, should be 90-degree out of phase.  If the 
same edge transition is detected simultaneously on quadrature A and quadrature B signals, the error is 
declared.  

 

13.1.7 Bus over voltage 

VSA1 bus voltage over 100V. VSA2 bus voltage over 430V. 

 

13.1.8 Bus under voltage 

VSA1 bus voltage is under +24V. VSA2 bus voltage under 100V. 

13.1.9 Motor over temperature 

TBD. User can set motor thermal resistance. 

 

13.1.10 Amplifier over temperature 

The amplifier inverter temperature is over 70-degree C. 

 

13.1.11 +5V output supply fault 

+5V voltage output over current or over temperature.  

 

13.2 Warnings 
Current GUI does not support warning codes.  Will be implemented in next GUI release. 
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14  Firmware Upgrade 
The VaredanGUI should be used as the primary tool for updating drive firmware.  If this option is not 
available, the 3rd party C2Prog program can also be used.  Contact Varedan Engineering for firmware 
images for different upload procedures. 

 

14.1 Update firmware from GUI 
Step 1:  From GUI pull-down manual, select Tools->Update Firmware 

 

 

Step 2:  Select the firmware image file to be uploaded.  Click “Open”. 

 

 

Step 3:  Waiting for uploading to be complete.  After complete, on “Software Update Complete” menu, 
click “OK”.  VSA drive get reset and new firmware version should show on GUI right corner.  
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14.2 Update firmware from C2Prog 
Step 1:  Download and install CodeSkin C2Prog v1.7j from the following link: 
http://www.codeskin.com/c2prog-download 
C2Prog will be used to flash the firmware hex file onto the VSA amplifier. 

Step 2:  Connect serial cable from PC to the VSA amplifier’s RS232 port, P4. 

Step 3:  Short P4 pin-5 and pin-6 for DSP programing mode before powering on the drive. When power is 
turned-on, the status LED should be solid orange, indicating that the amplifier is in Firmware Flash Mode. 
If it is not, power down the amplifier and repeat the process. 

Step 4:  Open C2Prog and select the firmware hex file from its saved location as shown. 

 

 

Step 5:  Expand the Programming Configuration section as shown by clicking on the double arrows. 
 
Set the following fields as shown: 

• Target: 28375,7,9S 
• Options: 16MHz 
• Smart Sector Selection: checked 
• Port: Serial 



VSA Series Digital PWM Servo Amplifier Technical Reference Manual 

56 
 

 

 

Step 6:  Click on the “Configure Ports...” button to open the Port Configuration pop-up. 

Step 7:  Click on the “Scan Ports” button and select the appropriate port from the pull-down menu. 
Close the Port Configuration pop-up window after the correct port has been selected. 

Step 8:  Click on the “Program” button to flash the firmware hex file onto the amplifier. 

Step 9:  Verify that the “Programming...OK” dialogue is present and close the Programming pop-up 
window. 

Step 10:  Recycle power of the amplifier.  Be aware of previous user settings of the amplifier are wiped 
out at this moment.  User needs to re-configure the amplifier from GUI or host terminal, or to reload the 
saved configuration file. 

 

15  Serial Command Interface 

15.1 Command Category 
The serial commands are grouped as 3 categories, immediate, configuration, and status.  Immediate 
commands tell the amplifier executes the command immediately.  Configuration commands define the 
amplifier and motor parameters.  Status commands monitor the status of the amplifier.  

 

15.2 Command format 
Commands are entered using ASCII characters from the terminal.  To enter a command with a user entered 
data field, the command name is followed by a “:” or “=” followed by the data for the command, followed by 
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Enter (carriage return) is used. As a minimum, all commands must be terminated by the carriage return 
character (ASCII 13). The line feed (ASCII 10) is optional and is not used by the amplifier. 
A typical command has the following ASCII format.  Control characters are shown in <>: 

CONFIG?<Cr><Lf> 

POLES=4<Cr><Lf> 

All characters sent to the amplifier are echoed back if echo has been enabled. When the amplifier has 
accepted the command, the prompt “>” is returned. 
Note: The “:” and “=” can be used interchangeably to separate a command from the input parameter data. 
The command data types are as follows: 

Integer  ex: 100 
Float  ex: 23.456 
Character  ex: ABC 

Configuration and status commands can be directly queried for their values by appending a “?” to the end 
of the command. For example: 

>AMPMODE? 
>4 

would indicate an amplifier mode of “4” which is 3-phase torque mode. 

Commands and values are case sensitive with commands requiring upper case convention. If the VSA 
encounters a problem any command it receives, it will respond with the following error states: 

Error Message Description 

Invalid Command Command was not recognized as a valid command 

Invalid Parameter Command parameter was not in the proper format 

Invalid Mode Requested operation is not valid in current operating mode 

Invalid While Enabled Requested operation is not available while amplifier is Enabled 

Data Range Error Command parameter is outside the valid range 

 

15.3 Command List 
In this list, data type “f” indicates float, “n” or “x” indicates integer, and “c” indicates a character. 

 

15.3.1 ACCEL:f 

Set desired acceleration rate. 

Category Configuration 
Parameter float 
1.0 to 40,000.0 Acceleration in user units/sec2 

 

15.3.2 ALARMREST 

Soft reset.  Clear all faults and warnings status.   

Category Immediate 
Parameter N/A 
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15.3.3 ALIGNMODE:n 

Select motor initialization (phasing) method. 

Category Configuration 
Parameter Integer 
n Description 
0 Hall sensors for motor initialization. No motion required. 
1 Halless, constant current motor phasing.  Motor moves. 
2 Absolute encoder, fixed phase angle offset 

 

15.3.4 AMPMODE:n 

Sets the operate mode of the amplifier.  The amplifier must be disabled to change the mode. 

Category Configuration 
Parameter Integer 
n Description 
0 Single phase motor torque/current control 
1 TBD.  Single phase motor velocity control  
2 TBD.  Single phase motor position control 
3 3-phase motor, 2-phase external commutation control (ABSine) 
4 3-phase motor torque/force/current control 
5 TBD.  3-phase motor velocity control 
6 TBD.  3-phase motor position control 
7 TBD.  3-phase open-loop 

 

15.3.5 ANALOGOUT:n 

Selects the analog output signal for user monitoring. 

Category Configuration 
Parameter Integer 
n Description 
0 Actual Position. TBD 
1 Position reference. TBD. 
2 Actual Velocity. TBD 
3 Velocity reference. TBD 
4 Phase A Current (Amp) 
5 Phase B Current (Amp) 
6 Phase C Current (Amp) 
7 TBD 
8 dq axis current, Iq (Amp) 
9 dq axis current, Id (Amp) 
10 CMD A analog input (voltage) 
11 CMD B analog input (voltage) 
12 CMD A analog input (voltage) 
13 CMD B analog input (voltage) 
14 TBD 
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15 TBD 
16 Test signal, motor electrical angle (degree) 

 

15.3.6 ANALOGAPOL:n 

Sets input polarity for CMD A analog input. 

Category Configuration 
Parameter Integer 
n Description 
0 Normal 
1 Inverted the signal 

 

15.3.7 ANALOGBPOL:n 

Sets input polarity for CMD B analog input. 

Category Configuration 
Parameter Integer 
n Description 
0 Normal 
1 Inverted the signal 

 

15.3.8 AOUTPOL:n 

Sets polarity of the analog output signal, selected by ANALOGOUT command.  Signal level 0 references 
to 2.5V. 

Category Configuration 
Parameter Integer 
n Description 
0 Normal  
1 Inverted the signal  

 

15.3.9 AOUTSCALE:f 

Scales the dynamic range of the analog output signal.  The analog output signal is selected by 
ANALOGOUT command.  For example, 

> ANALOGOUT:4 Selects Phase A Current as the analog output signal 

> AOUTSCALE:0.5 Set the analog output scale to 0.5VDC / Amp 

Category Configuration 
Parameter float 
1e-6 to 1e6 Analog output signal scale factor 

 

15.3.10 CCLIMIT:f 

Sets the continuous motor current limit in Amps. This value is also used to determine the I2T protection 
limit.  When the motor current exceeds this setting, the motor i2t over current protection becomes active. 
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Category Configuration 
Parameter float 
0.0 to 10.0 VSA1 – Continuous current in Amps 
0.0 to 25.0 VSA2 – Continuous current in Amps 

 

15.3.11 CIGAIN:f 

Sets current loop integral gain value.  CIGAIN? reads the setting value. 

Category Configuration 
Parameter float 
0.0 to 200.0 Current PI controller, integral gain 

 

15.3.12 CPGAIN:f 

Sets current loop proportional gain.  CPGAIN? reads the setting value. 

Category Configuration 
Parameter float 
0.0 to 10000.0 Current PI controller, proportional gain 

 

15.3.13 COMMOFFSET:f 

Sets the commutation angle offset in electrical degrees. Typically used for the alignment of absolute 
feedback devices. 

Category Configuration 
Parameter float 
0 – 360.0 Electrical angle phase offset in degree 

 

15.3.14 COMMUTATION:n 

Sets the motor commutation mode. 

Category Configuration 
Parameter Integer 
0 TBD, 6 step Hall commutation 
1 Sinusoidal commutation 
2 TBD, 1.8-degree stepper 
3 TBD, 3.6-degree stepper 

 

15.3.15 CONFIG? 

Replies with a listing of the amplifier configuration in command format which can be saved to a file. 

Category Status 
Parameter N/A 
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15.3.16 DECEL:f 

Sets the desired deceleration in user units/sec2. 

Category Configuration 
Parameter float 
1.0 to 4000.0 Deceleration in user units/sec2 

 

15.3.17 DIR:n 

Sets the motor direction polarity as positive/clockwise or negative/counter-Clockwise.  Only active when 
the amplifier is Disabled. 

Category Configuration 
Parameter Integer 
0 Clockwise/positive 
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1 Counter-clockwise/negative 
 

15.3.18 ECHO:n 

Category Immediate 
Parameter Integer 
0 Echo off 
1 Echo on 

 

15.3.19 EN, ENABLE 

Enables the amplifier.  Don’t use this command if a hardware I/O is selected to be host enable signal 
input. 

Category Immediate 
Parameter N/A 

 

15.3.20 ENCODERCOUNT:n 

Sets the encoder feedback resolution.  For the incremental encoder, sets encoder counts per mechanical 
revolution for rotary motors, and sets encoder counts per pole pairs for linear motors.  The valid range of 
this value is determined by the feedback device type set by the ENCODERTYPE command. 

Category Configuration 
Parameter Integer 
Encoder type n 
Incremental encoder 200 to 100000 
Biss TBD 
DnDat TBD 
Sin/Cos TBD 

 

15.3.21 ENCODERTYPE:n 

Sets the main feedback encoder type. 

Category Configuration 
Parameter Integer 
n Description 
0 No encoder feedbacks 
1 Incremental quadrature encoder 
2 Biss 
3 DnDat 
4 Analog encoder Sin/Cos 

 

15.3.22 EXTCMDIN:n 

Selects the external input command source.  This command has no effect when AMPMODE:3 is selected 
which uses both CMD A and CMD B as primary command inputs. 

Category Configuration 
Parameter Integer 
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n Description 
0 No external command source 
1 CMD A Input as the command source 
2 CMD B Input as the command source 
3 TBD, external reference 
4 TBD 
5 TBD 

 

15.3.23 FAULTS? 

Returns faults as a bit encoded binary word.   

Category Status, binary 
Parameter N/A 
FAULTS? Description 
Bit 0 Non-volatile memory checksum error 
Bit 1 TBD 
Bit 2 Motor feedback 
Bit 3 Following error 
Bit 4 Motor over speed 
Bit 5 Logic power error 
Bit 6 Bus over voltage 
Bit 7 TBD 
Bit 8 Amplifier fault, short circuits 
Bit 9 Over current 
Bit 10 Amplifier inverter over temperature 
Bit 11 Motor over temperature 
Bit 12 Bus under voltage 
Bit 13-15 TBD 

 

15.3.24 FAULTSA? 

Returns an ASCII list of active faults otherwise returns “OK”. 

Category Status 
Parameter N/A 

 

15.3.25 GAINS? 

Lists control loop gain settings.  Current PI loop CPGAIN, CIGAIN, CINTLIMIIT.  Velocity PI loop 
VPGAIN, VIGAIN, VINTLIMIT.  Position PID loop PPGAIN, PIGAIN, PDGAIN, PINTLIMIT. 

Category Status 
Parameter N/A 

 

15.3.26 HALLS:ccc 

Sets the hall state relationship to the motor phases.  Default is “ABC”.  For example, HALLS:ACB swaps 
hall phase B and C.  If motor initialization (phasing) using hall sensors, users must set the correct hall 
sequence. 

Category Configuration 
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Parameter Character  
ccc A, B, C 

 

15.3.27 HELP? 

Lists all available user commands. 

Category Status 
Parameter N/A 

 

15.3.28 I? 

Lists 3 phase currents, one per line. 

Category Status 
Parameter N/A 

 

15.3.29 INPOL:x:n 

Sets the active level or edge trigger for input number x 

Category Configuration 
Parameter Integer 
x Input I/O number 
User I/O input number 1 to 5 
n Trigger type 
0 Active low 
1 – default  Active high 
2 Positive edge 
3 Negative edge 

 

15.3.30 INPUTS? 

Returns a binary word that is bit encoded with the state of the inputs. 

Category Status 
Parameter N/A 
State bits Description 
Bit 0 IN1, user input #1 
Bit 1 IN2, user input #2 
Bit 2 IN3, user input #3 
Bit 3 IN4, user input #4 
Bit 4 IN5, user input #5 
Bit 5 Hall A 
Bit 6 Hall B 
Bit 7 Hall C 
Bit 8 STO 
Bit 9 Encoder index latched 
Bit 10 Auxiliary encoder index latched 
Bit 11-15 TBD 
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15.3.31 INPUTSA? 

Returns an ASCII list of the state of the inputs.  Check bits description in INPUTS? command. 

Category Status 
Parameter N/A 

 

15.3.32 JERK:f 

Sets user desired maximum jerk limit value.   

Category Configuration 
Parameter float 
0.0 to 40000.0 Jerk limit in user units/sec2 

 

15.3.33 MAPIN:x:n 

Configures user input pin x functionality.  For example: MAPIN:2:1 maps input #2 as the amplifier enable. 

Category Configuration 
Parameter Integer, integer 
x Input channel number 
User I/O input number 1 to 5 
n Functionality 
0 – default  General purpose user input 
1 Enable amplifier 
2 TBD.  Defines bit in program selection number 
3 Limit+, motion positive limit 
4 Limit-, motion negative limit 
5 TBD. Stops motor using preset deceleration value. 
6 SFI, special user function input 
7 Hard reset 

 

15.3.34 MAPOUT:x:n 

Configures user I/O output number x functionality.  For example: MAPOUT:2:1 maps output #2 as a Fault 
Output.  Active level is defined in OUTPOL:x:n command. 

Category Configuration 
Parameter Integer, integer 
x Output channel number 
User I/O output number 1 to 3 
n Functionality 
0 – default  General purpose user output 
1 Fault 
2 TBD.  At speed. 
3 TBD.  Zero speed. 
4 TBD  
5 TBD.  At position. 
6 Disable.  Amplifier is disabled if asserted.  
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15.3.35 MONITOR? 

Lists the measured bus voltage, keep alive voltage, and the amplifier temperature.  Voltage 
measurements may have 10% variation to its real values. 

Category Status 
Parameter N/A 

 

15.3.36 MOTOROVERTEMP:x:n 

Sets the motor over-temp protection mode and the sensor resistance threshold. 

Category Configuration 
Parameter Integer, integer 
x Thermistor type 
0 – default  Disabled  
1 NTC sensor 
2 PTC sensor 
n Description 
0 to 500,000 Thermal resistance in ohm 

 

15.3.37 MOTORTEMP? 

Returns the motor temperature sensor resistance in ohms. 

Category Status 
Parameter N/A 

 

15.3.38 OUTPOL:x:n 

Sets the active level polarity for output number x. 

Category Configuration 
Parameter Integer, integer 
x Description 
1 to 3 User I/O output number 
n Description 
0 Active Low 
1 – default  Active High 

 

15.3.39 OUTPUTS? 

Returns a binary word that is bit encoded with the state of the outputs. 

Category Status 
State bits Description 
Bit 0 OUT1, user output #1 
Bit 1 OUT2, user output #2 
Bit 2 OUT3, user output #3 
Bit 3:15 TBD 
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15.3.40 OUTPUTSA? 

Returns an ASCII list of the state of the user outputs. 

Category Status 
Parameter N/A 

 

15.3.41 PDGAIN:f 

Sets the position loop derivative gain. 

Category Configuration 
Parameter float 
f Description 
0.0 to 1000.0 Position PID controller, derivative gain 

 

15.3.42 PHASING:ccc 

Sets the motor leads relationship to the drive phase outputs.  This action equals to swap the motor lead 
wires. For example, PHASING:CBA swaps Phase A and C 

Category Configuration 
Parameter Character  
ccc Description 
ABC Drive phase A,B,C to motor leads A,B,C corresponding 
CBA Swap drive phase A and C outputs 

 

15.3.43 PIGAIN:f 

Sets the position loop integral gain. 

Category Configuration 
Parameter float 
f Description 
0.0 to 1000.0 Position PID controller, integral gain 

 

15.3.44 PKLIMIT:f 

Sets the peak current in Amps for protection.  If any motor phase current is over the given peak current, 
the amplifier gets disabled and over current fault will be reported.  This value is also used to calculate I2T 
limit to trigger I2T fault. 

Category Configuration 
Parameter float 
f Description 
0.0 to 12.0 VSA1 – Peak current in Amps 
0.0 to 40.0 VSA2 – Peak current in Amps 

 

15.3.45 PKTIME:f 

Sets the peak current time in seconds.  This value is also used to calculate I2T limit to trigger I2T fault. 
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Category Configuration 
Parameter float 
f Description 
0.0 to 25.0 Peak time in seconds to calculate I2T limit 

 

15.3.46 POLES:n 

Sets the number of magnetic motor poles (NOT pole pairs). 

Category Configuration 
Parameter integer 
n Description 
0 to 100 Number of magnetic poles 

 

15.3.47 PPGAIN:f 

Sets the position loop proportional gain. 

Category Configuration 
Parameter float 
f Description 
0.0 to 1000.0 Position PID controller, proportional gain 

 

15.3.48 REGENVOLT 

For VSA2 only, sets the bus voltage threshold for regen on. 

Category Configuration 
Parameter integer 
n Description 
100 to 420 Bus voltage in volt to turn on regen circuits 

 

15.3.49 REGENPWMDC 

For VSA2 only, sets regen PWM control duty cycle. If duty cycle equals to 0, regen gets disabled. The 
minimum on duty cycle is 5%. For the duty cycle input less than 5% will be set as 5%. 

Category Configuration 
Parameter integer 
n Description 
0 to 100 Regen PWM duty cycle in percentage 

 

15.3.50 RESET 

Performs a hard reset of the amplifier. 

Category Immediate 
Parameter N/A 
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15.3.51 S? 

Returns the binary value of the 16-bit status flags.  For ASCII version, see SA? 

Category Status 
Parameter N/A 

 

15.3.52 SA? 

Returns the hex ASCII value of the 16-bit status flags. 

Category Status 
Flag bits Description 
Bit 0 Enable 
Bit 1 TBD,  Zero speed 
Bit 2 TBD,  At speed 
Bit 3 TBD,  Motion direction 
Bit 4 STO 
Bit 5 TBD.  At position 
Bit 6 Fault 
Bit 7 TBD,  encoder index captured 
Bit 8-15 N/A 

 

15.3.53 SETOUTPUT:x:n 

Set the state of a general purpose output, where x is the output number 1-3 and n is the desired state 0 or 
1.  Note that the I/O pin must first be configured as user output using the MAPIO:x:n command to map 
the output n as a general purpose user output.  For example,  

Map Output 2 as a general purpose output:  MAPIO:2:1 

Set output 2 to 1:  SETOUTPUT:2:1 

OUTPOL:x:n defines output active level.  If SETOUTPUT:2:1 command drives output #2 pin is high, if 
the pin is defined as active high.  Otherwise, output #2 pin is low, if the active low is set as active low. 

Category Immediate 
Parameter Integer, integer 
x Description 
1 to 3 User I/O output number 
n Description 
0 or 1 Output State 

 

15.3.54 SININTERP:n 

Sets the interpolation bits of analog Sin/Cos encoders. 

Category Configuration 
Parameter Integer 
n Description 
1 to 16 Encoder interpolation bits 
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15.3.55 SPD? 

Responds with the actual speed of the motor in user units. 

Category Immediate 
Parameter N/A 

 

15.3.56 SWAP:n 

Swap encoder counting direction. 

Category Configuration 
Parameter Integer 
n Description 
0 Normal counting 
1 Invert encoder counting direction 

 

15.3.57 SWUPDATE:n 

Places the amplifier into Bootloader mode to receive a new system software update over the specified 
communication interface. 

Category Immediate  
Parameter Integer 
n Description 
1 SCI (serial) 
2 TBD.  UDP (Ethernet) 

 

15.3.58 TBASE:n 

Selects the data trace time base per division on the digital scope. 

Category Configuration 
Parameter Integer 
n Time base per Division 
0 2.5 ms 
1 5.0 ms 
2 10 ms 
3 25 ms 
4 - default 50 ms 
5 100 ms 
6 250 ms 
7 500 ms 
8 1 sec 

 

15.3.59 TLVL:f 

Sets the data trace trigger level. The data trace trigger signal source is fixed to trace #1. 

Category Configuration 
Parameter float 
f Description 
10e-6 to 10e6 Scope trace trigger level 
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15.3.60 TMODE:n 

Selects the data trace trigger mode of the digital scope. 

Category Configuration 
Parameter integer 
n Description 
0 – default  Auto 
1 Normal 
2 Single 

 

15.3.61 TPOS:n 

Sets the data trace horizontal trigger position of the digital scope. 

Category Configuration 
Parameter integer 
n Description 
0 – default  25%, trigger position at 1/4 of the trace time window 
1 50%, trigger position at the middle of the trace time window 
2 75%, trigger position at 3/4 the trace time window 

 

15.3.62 TRACE:x? 

Returns the captured binary data buffer for the selected channel. 

Category Immediate 
Parameter Integer 
n Description 
0 Both channels 
1 – default Trace #1 
2 Trace #2 

 

15.3.63 TSIG:x:n 

Selects the data trace channel signal where x is the channel number and n is the signal. 

Category Configuration 
Parameters Integer, integer 
x Channel # 
1 Trace #1 
2 Trace #2 
n Signal index 
0 apos, actual position 
1 dpos, position reference 
2 avel, actual velocity 
3 dvel, velocity refence 
4 Ia, motor phase A current 
5 Ib, motor phase B current 
6 Ic, motor phase C current 
7 N/A 
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8 Iq, 3-phase synchronous control, dq axis current 
9 Id, 3-phase synchronous control, dq axis current  
10 CMD A  
11 CMD B 
12 CMD A 
13 CMD B 
14 N/A 
15 N/A 
16 Test signal (electrical angle) 

 

15.3.64 TSLOPE:x 

Sets the trigger slope of the digital scope. 

Category Configuration 
Parameter Integer 
n Description 
0 Positive 
1 Negative 

 

15.3.65 UNIT:ccccc 

Sets the user unit label for motion parameters limited to 5 characters.  

Category Configuration 
Parameter Character A to Z 
ccccc Description 
REVS Position or Velocity  

 

15.3.66 VELUNIT:n 

Sets the units of time for velocity commands as seconds or minutes. 

Category Configuration 
Parameter Integer 
n Description 
0 Per second  
1 Per minute 

 

15.3.67 VERSION? 

Returns the unit IDs and software revision. 

Category Status 
Parameter N/A 

 

15.3.68 VIGAIN:f 

Sets the velocity loop integral gain. 

Category Configuration 
Parameter float 
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f Description 
0 to 1000.0 Velocity PI controller, integral gain  

 

15.3.69 VPGAIN:f 

Sets the velocity loop proportional gain. 

Category Configuration 
Parameter float 
f Description 
0 to 1000.0 Velocity PI controller, proportional gain  

 

15.3.70 WRITE 

Saves the user parameter settings to flash memory. 

Category Immediate 
Parameter N/A 
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16  Sales and Services 
Varedan Technologies warrants this product to be free of manufacturing defects for a period of 1 year.  If 
your product requires services, please contact our factory for troubling information and if needed, return 
material authorization (RMA) information. 
 
Varedan Technologies 
3860 Del Amo Blvd 
Suite 401 
Torrance, CA 90503 
 
1-310-542-2320 
 
 
 
 


